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s, P Multiwavelength Analysis

Astrophysical context
— Source association
— Emission mechanisms
Fermi data probe a region of the spectrum that
— Can be the high energy anchor for your model
— Or bridge lower energy regimes and TeV

How you fit/extrapolate/interpolate over many decades can
strongly influence the physical models you walk away with,
and correctly accounting for errors over those decades is
really important



s ey Caveats

| stole borrowed some of this material from Alan Marscher’s
2012 Fermi Summer School Talk and reworked from my 2017
talk

— See Alan’s talk for a more blazar focused discussion
| will use a GRB as an example, but most of this is
relevant/applicable to other source types
2 primary ways to build an SED

— Input ~raw data, response functions, etc. and fit the whole
spectrum together

— Collect individually fit datasets and combine them fitting
more complex physical models around already fit model
dependent data (will come back to this issue)

There are lots and lots of ways to do this

— Software (XSPEC, RMFIT, Sherpa, likelihood, 3ML, custom
software ...)

— Units (energy, frequency, wavelength, ...)
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@ ormi Neasuring a spectrum across the spectrum

« Radio/mm/microwave
— temperature -> flux density
— In frequency
IR/Optical/UV
— magnitudes in different filters
— F,=10x%4m" mJy where k depends on filter used
— Must account for extinction in UV/blue
— In wavelength
X-ray
— counting photons -> flux
— Must account for N, absorption <1 keV
— Conversion depends on shape of spectrum
Gamma-ray
— counting photons -> flux
— Likelihood often used to fit spectrum, background, etc.
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= ermi Broadband Spectral Energy Distributions (SEDs)
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@5, ermi Spectral Energy Distributions

Gamma ray

/ Space Telescope
« We want to plot of log,,VvF, vs log,,v

 How is this measured?

Measure Unit Formula Measured Details
known as where?
Photon Flux phcm?s N(E)=AET X-ray, y-ray  Instrument
Density* keV- (example) dependent
Spectral Flux erg cm= s f,.=EN(E)=BE® X-ray,y Specific energy
Density keV-1 Optical, radio a=I-1
or or Jy or mag 1 kev = 1.602x10°
Energy Flux* erg
Luminosity* ergs'keV-! L=f, 41rD? k X-ray, y k=k-correction,
D=distance
Spectral erg cm2 s v f,=E2 N(E) Combined
Energy broadband
density spectrum

*Integrate from E4-E, to get flux measurement in specific band for light curves
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Gamma-ray
/ Space Telescope

Broadband Spectral Energy Distributions (SEDs)
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s, eyl Importance of Simultaneity
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A Extinction and Absorption

Gamma-ray
Space Telescope
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A Extinction

Gar"ma ray

/' Space Telescope

Wavelength A
 Interstellar dust absorbs and scatters 5500 3000 T ( )1500 1215

some of the IR, optical, UV light ‘ ' 7

« Different dust composition or grain — FM90 Rv=3.16 A il
size impacts absorption & scattering g _ondime LV amsElS J

—-- SMC .

«  Well-mapped for Milky Way, LMC, ompglLLilE

~~~~~ Milky Way
SMC 5 o
. A=E(B-V) x Ry U .
— R, set specifically for MW, LMC, =

SMC L
— Fit E(B-V) or Ay
— Get it from NED ,

— Get it from literature where o
someone else has already fit it for :
the same object

« Cardelli et al. 1989 provides relations Schady et al. 2012
between Ay and other wavelengths, Pei 1992
though depends on extinction curves

« XSPEC models (z)dust
http://heasarc.gsfc.nasa.gov/xanadu/xspec/manual/XSmodelZdust.html

4 5 6 7 8 9
Inverse wavelength (1/im)



http://heasarc.gsfc.nasa.gov/xanadu/xspec/manual/XSmodelZdust.html

s ermi X-ray Absorption

Interstellar neutral hydrogen gas
absorbs soft X-rays

— Photo-electric absorption using
some set of photo-ionization
cross-sections

2 sources of absorption for
extragalactic sources (Ny — hydrogen
column density)
— Galactic — well mapped by
Kalberla et al. 2005

- ftool NH

* http://heasarc.gsfc.nasa.gov/cgi-
bin/Tools/w3nh/w3nh.pl

— Intrinsic absorption should be fit,
can account for redshift (if known)

XSPEC models (z)wabs, (z)phabs




s, P Adding y-rays to SEDs

amma-ray

Likelihood analysis needed to determine contribution of source
and background components (fit/assume spectral model)

If y-ray source well characterized (bright), and the shape can be
constrained (e.g. powerlaw) independently, you can just use
results of likelihood over-plotted with broadband SED

— Use bowtie shape to represent uncertainties centered at v,
- o.F(V) = (V/ Vref)_a [In(V/ Vref)zo.a2 + o.F2 (Vref)]”2
« usually v, =2.42x10"7 Hz = 1 keV

Taking into account
. error on both
normalization (flux)

and slope

log VvF,

1
vref i

log v
However, if shape of y-ray spectrum affected by data in nearby
parts of the spectrum (breaks, curvature, cutoffs, etc.), you
should do joint fits given a spectral model, and solve for free
parameters



A vFv Spectra are Model Dependent
o S Tacior
* In order to take data from raw (counts, magnitudes etc.), you must
assume

— Instrumental response function - which can depend on event class
(LAT), readout mode (X-ray), filter (optical/IR/UV)

— Background

* Instrumental can depend on temperature of detector, hot
pixels/strips

- Particle background — depends on proximity to SAA, orbit, solar
activity
* Real sources - earth, moon, sun, astrophysical sources, Galaxy,
etc.
— Things getting in the way
« Extinction, absorption, emission lines, EBL
« To get to flux, you fit a model to your spectrum
« VFv is your unfolded (remove model and all of above) spectrum
— So fitting a model to your vFv spectrum is kind of cheating ...
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@ ML vFv Spectra are Model Dependent
SpmeToenops
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A vFv Spectra are Model Dependent

Gamma-ray

/ Space Telescope
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Binned counts spectrum
(only binned for plotting purposes)
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A vFv Spectra are Model Dependent

Gamma-ray
Space Telescope
data and folded model
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Gamma-ray
/ Space Telescope
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Unfolded Spectrum
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Fit to Band function (grbm in XSPEC)
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A vFv Spectra are Model Dependent

Gamma-ray
/ Space Telescope

Unfolded Spectrum
_ GRB 110731A
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residuals

vF, = E2N(E) spectrum
Fit to Band function (grbm in XSPEC)



s, ey vFv Spectra are Model Dependent
Spoe T
Unfolded Spectrum

il o]

» Therefore, viFv SEDs are not model-independent
* Residuals and fit statistics, are a better way to judge how well
the data fit the model
» Plotting data with best fit model can bias the reader towards the
validity of your model
« Used inconsistently in different fields
* LAT team generally plots model + residuals
« Thisi is all just a note of caution!
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residuals

vF, = E2N(E) spectrum
Fit to Pow+Band function (pow+grbm in XSPEC)
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A vFv Spectra are Model Dependent

Gamma-ray
Space Telescope

Current Theoretical Model
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Fit to Pow+Band function (pow+grbm in XSPEC)



s, YL Let’s build a really simple SED

Extract LAT Spectra
— Standard Science Tools Method
+ gtmktime
« gtselect
« gtitcube
« gtexpmap
« gtdiffrsp
+ gtlike
+ (gtfindsrc)
» gtbin
« gtrspgen
+ gtbkg
« http://fermi.gsfc.nasa.qov/ssc/data/analysis/scitools/lat grb analysis.
html|
— Shortcut/Wrapper Method
« gtburst
» https://fermi.gsfc.nasa.gov/ssc/data/analysis/scitools/gtburst.html



http://fermi.gsfc.nasa.gov/ssc/data/analysis/scitools/lat_grb_analysis.html
http://fermi.gsfc.nasa.gov/ssc/data/analysis/scitools/lat_grb_analysis.html
https://fermi.gsfc.nasa.gov/ssc/data/analysis/scitools/gtburst.html

s, YL GRB Specific Uses of Event Classes

 LAT Low Energy (LLE)

— really loose event classification that can be used down to
~30 MeV, useful during brightest part of bright bursts when
source is really bright compared to background

* Transient class

— Useful during bright prompt burst itself, while source in
counts limited

« Source class

— Useful over longer intervals like long extended emission
(100°s-1000’s of seconds)
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@ M GRB Analysis Tools
/ Gamma-ray
v v Tgtburst
— Python GUI interface for
+ downloading GBM/LLE/LAT data
» selecting background and source intervals (GBM, LLE)
* likelihood analysis of LAT data
* Localizing LAT GRBs
— Also useful for other short transients (e.g. Solar Flares)
— Is part of the science tools, but updates via git separately
— Itis on your VM now
— Written by Giacomo Vianello & Nicola Omodei (LAT team)
« rmfit
— IDL GUI for selecting background and source intervals
— Spectral fitting of GBM data
— Available on FSSC user contributed tools
— Written by Rob Preece, Adam Goldstein (GBM team)
- GBM Data Tools (Gamma-ray Data Tools)
— Python tools for downloading, extracting, and fitting GBM data
— Available on FSSC and github
— Written by Adam Goldstein and others
« XSPEC
— Standard tool in X-ray astronomy
— Written by Keith Arnaud (NASA/GSFC)
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Common Time Interval
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Gamma-ray
Space Telescope

« Simultaneously detected by
Swift & Fermi
— GBM, LAT clearly detected
— BAT, XRT, UVOT + ground-
based observations

e Ackermann et al. 2012

— Multiwavelength Observations of GRB
110731A: GeV Emission from Onset to
Afterglow
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< i GBM/LAT GRB Tutorial

Extract Data for GBM & LAT
Likelihood analysis of LAT data using gtburst

— Get simple fit to LAT spectrum, and contribution from
background

Get both GBM & LAT data in XSPEC
— Joint band function fit
— Different statistics for different instruments
- GBM - C-stat
 LAT - pgstat (Poisson data with Gaussian background)



amma-ray

GBM/LAT GRB Tutorial

Data for tutorial
— Extract it yourself
« gtburst — we’ll walk through it
— Or grab data | already extracted
« https://confluence.slac.stanford.edu/download/attachme

nts/382927547/NotesOnLightCurves.pptx?version=1&m
odificationDate=1685826922000&api=v2

« put grb110731a_xspec.tar.gz in shared directory
 in your docker image home directory, type:

 mkdir grb110731a

 cd grb110731a

 mv /data/grb110731a_xspec.tar.gz .

 tar xvfz grb110731a_xspec.tar.gz .



https://confluence.slac.stanford.edu/download/attachments/382927547/NotesOnLightCurves.pptx?version=1&modificationDate=1685826922000&api=v2
https://confluence.slac.stanford.edu/download/attachments/382927547/NotesOnLightCurves.pptx?version=1&modificationDate=1685826922000&api=v2
https://confluence.slac.stanford.edu/download/attachments/382927547/NotesOnLightCurves.pptx?version=1&modificationDate=1685826922000&api=v2

CA— Tutorial Next Steps

Option 1 — skip to XSPEC
Option 2 — walk through LAT GRB analysis with Gtburst
Caveat

— You should be able to also select time intervals for GBM
data in Gtburst, but | couldn’t get it to work last night

— You can select GBM intervals and spectral files with the
gbm data tools, which | did

— All of these files are in the tar file



A GBM/LAT GRB Tutorial

« (gtburst
— Update - always a good idea

= Fermi bursts analysis GUI

File Tasks Tools Update
Trigger nan Update to the last development version...
R.A. (J2000) '
Dec. (J2000) \

Trigger date (MET)

1Tl

Gamma-ray Space Te

J

OO+ BB

With this applicau’on you can download Fermi data for Welcome to the Fexrmi Burst Analpsis 6UI v. 01-00-00p25!
GRBs and Solar Flares, compute source and

Credits: 6.Vianello (giacomov@slac.stanford.edu), N.omodei (nicola.omodei@gmail.com)
background spectra for GBM and LAT/LLE data,
Y . . . . This software embeds:
perform likelihood analysis and observation simulation -gtapps_mp by J. Perkins (http://fermi gsfe.nasa.gov/ssc/data/amalysis/user/)
with standard LAT data. “RPlpy (httpi//aplpy.qithub.io/)

These packages are property of the respective authors.

.

& To begin, click on the File menu.




gtburst

GBM/LAT GRB Tutorial

— Download LAT dataset

File | Tasks Tools Update

Load data from a directory...
Load a custom clataset...
Download datasets...
Change trigger time...
Reset...

Configuration...

Quit

With this application you can download Fermi data for
3RBs and Solar Flares, compute source and
ryackground spectra for GBM and LAT/LLE data,
serform likelihood analysis and observation simulation
with standard LAT data.

& To begin, click on the File menu.

erimi

Gamma-ray Space Tel

OO+ - BH
=l - r
Welcome to the Fermi Burst ARnalysis 6UI v. 01-00-00p25!

Credits: 6.vianello (giacomov@slac.stanford.edu), N.omodei (nicola.omodei@gmail.com)

This software embeds:

~gtapps_mp by J. Perkins (http://feomi gsfc.nasa. gov/ssc/data/analusis/usec/)
-RPlpy (http://a .qithub. 30/)

These packages are property of the respective authors.

i
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Gar"ma ray

/' Space Telescope

GBM/LAT GRB Tutorial

« (gtburst
— Browse GBM/Swift triggers, or enter manual info

Fermi bursts analysis GUI 2 w55

File Tasks Tools Update

Trigger name |
R.A. (J2000) : -
= HeTTni |
& W

Download data

i » Telescope !
Trigger name: LJ Browse triggers | |
Trigger time: ? |
RA. J
Dec. ? ‘

[~ Download GBM data
[ Download LLE data
[ Download LAT standard data (Transient and cleaner classes)

Download data ‘ Cancel |

Please insert a trigger name/number, and select which data you want to
download.You can also download trigger data directly from the HEASARC
clicking on these links: GBM data, LAT LLE data. Moreover, you can
download GBM daily data here and LAT photon data here.

With this application you can download Fermi data for ¥ Insert manually the trigger number, or click on '‘Browse triggers' to Al
GRBs and Solar Flares, compute source and dowmnload the list of all triggers from the HEASARC website and select from fei@gmail. com) |
background spectra for GBM and LAT/LLE data, there.
perform likelihood analysis and observation simulaton nser/)
with standard LAT data. T Er YTy
These packages are property of the respective authors, ||
¥

& To begin, click on the File menu.
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Gamma-ray

/ Space Telescope

« (gtburst
— Choose your trigger

S — F e —— — —

M, Fermi bursts analysis GUI e X

File Tasks Tools Update

Trigger name
R.A. (J2000)
Dec. (J2000) 3
Trigger date (MET) | m '
0 Download data x
File
Trigger name: ? Browse triggers |
gge
File
Trigger type filter: A —
Mame | TriggerTime(Mety  Type  Ra(Deg)  DeciDeq)  EmorRadius(Deg) | Localizing nstrument | |
bn110731068 333769039342 LOCLPAR 300233 47267 207000 Fermi,GBM
bn110731465 ] Swift, XRT
bn110801335 333878505086 GRB 248270 -57.060 7.3000 Fermi,GBM
bn110801661 333906747 658 TGF 289.483 15700 348833 Fermi, GBMFSW
bn110801718 333911651.794 SFLARE 131.391 18016 0.0000 Sun i
bn110802167 333950393765 SFLARE 131.828 17.903 0.0000 Sun
bn110803292 334047625427 SFLARE 132315 17614 0.0000 Sun
bn110803564 334071138854 SFLARE 133.178 17.544 0.0000 Sun
With this application you can| bn! 10803576 334072209.538 SFLARE 133.190 17.540 0.0000 Sun
GRBs and Solar Flares, com] bn110803783 334090047 428 GRB 300.420 -11.440 7.4900 Fermi,GBM v
background spectra for GBMij =
perform likelihood analysis aj o c
with standard LAT data.
Click on a column to sort the table (or invert the sorting)

& To begin, click on the File menu.



gtburst
— Choose the dataset

GBM/LAT GRB Tutorial

— 10000 is standard interval to search

File Tasks Tools Update

Trigger name
R.A. (J2000)
Dec. (J2000)

Trigger date (MET)

With this application you can download Fermi data for
GRBs and Solar Flares, compute source and
background spectra for GBM and LAT/LLE data,
perform likelihood analysis and observation simulation
with standard LAT data.

. Tobegin, click on the File menu.

Fermi bursts analysis GUI

T'p'

m

Download data

File
Triggername:  |bn110731465 ? | Browsetiggers
Triggertime:  333803371.954 ? |

RA. 280.504 ? |
Dex. -28.537 ? |

| Download GBM data
| Download LLE data
Iv Download LAT standard data (Transient and cleaner classes)

Download data | Cancel

Please insert a trigger name/mumber, and select which data you want to
download.You can also download trigger data directly from the HEASARC
clicking on these links: GBM data, LAT LLE data. Moreover, you can
download GBM daily data here and LAT photon data here.

Insert manually the trigger number, or click on 'Browse triggers' to

(7
download the list of all triggers from the HEASARC website and select from 1o i@gmail. com)
there.

fusex/)

eayy \MEY “w ' ot 7

These packages are property of the respective authors,
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— wait ...

| NON
File Tasks Tools Update |

Trigger name l

RA. (J2000) | |

GBM/LAT GRB Tutorial

N\ Fermi bursts analysis GUI
\ Fermi bursts analysis GUI

Waiting for the server to complete the query (estimated time: 266 seconds)... I

Dec. (J2000)
Trigger date (MET)

With this application you can download Fermi data
for GRBs and Solar Flares, compute source and
background spectra for GBM and LAT/LLE data,
perform likelihood analysis and observation
simulation with standard LAT data.

& To begin, click on the File menu.

Fermmi

Gamma-ray Space Telescope

#€IPQ=0

Energy range (MeV)

Search radius (degrees)

60

The estimated time for your query to complete is 266 seconds. The results of
your query may be found at <http://fermi gsfc nasa gov/cgi-
bin/ssc/LAT/QueryResults. cgi?1d=L17060111543414FB177F98>




gtburst

GBM/LAT GRB Tutorial

— or grab data from directory

File | Tasks Tools Update

Load data from a directory...
Load a custom clataset...
Download datasets...
Change trigger time...
Reset...

Configuration...

Quit

With this application you can download Fermi data for
3RBs and Solar Flares, compute source and
ryackground spectra for GBM and LAT/LLE data,
serform likelihood analysis and observation simulation
with standard LAT data.

& To begin, click on the File menu.

erimi

Gamma-ray Space Tel

OO+ - BH
=l - r
Welcome to the Fermi Burst ARnalysis 6UI v. 01-00-00p25!

Credits: 6.vianello (giacomov@slac.stanford.edu), N.omodei (nicola.omodei@gmail.com)

This software embeds:

~gtapps_mp by J. Perkins (http://feomi gsfc.nasa. gov/ssc/data/analusis/usec/)
-RPlpy (http://a .qithub. 30/)

These packages are property of the respective authors.

i




gtburst

GBM/LAT GRB Tutorial

— or grab data from directory

File Tasks Tools Update

Trigger name |
R.A. (J2000) \
Dec. (J2000) }
Trigger date (MET) |

With this application you can download Fermi data
for GRBs and Solar Flares, compute source and
background spectra for GBM and LAT/LLE data,
perform likelihood analysis and observation
simulation with standard LAT data.

& To begin, click on the File menu.

X\ Fermi bursts analysis GUI

@] X\ Please select a directory containing data files
/homefvagrant/FermiData/bn110731465 el

Folder

® B cpan
5 .gtburst
= B .id
® @ pki
& ssh
= £ FermiData
[ bn0B0916009
[ bn110731465
& GRBs
B pfiles
B lib
1 B3 lib64
£ media
& mnt l
® & opt
® [ proc =

=

B ®

®

1

: todei (nicola.omodei@gmail. com)
New Folder...J OK J Cancel

. sc/data/analysis/user/)
-APlpy (http://aplpy. github io/)

These packages are property of the respective authors.
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« (gtburst
— Choose the dataset

™ Fermi bursts analysis GUI - 0O X
File Tasks Tools Update
Trigger name
R.A. (J2000)
Dec. (J2000) =] Select datasets 4
Trigger date (MET) | Fie 8 i
vn0 (20deg) vnl (44deg)
n2 (90deg) Wn3 (42deg)
n4 (87deg) [ n5 (87deg) e s aras Ta
vnB (22deg) vwn7 (47 deg) ]d’ld:‘v ?li’t1£L' l L‘IL' "
ng (90deg) wn3 (49deg) ; . |
na (93deg) nb (93 deg)
vb0 (87deg) [ bl (93deg)
VLAT ( 3deg) WLAT-LLE( 3deg)
Do NOT use GBM TTE files
(you loose time resolution!)
"
Ok 1
In parenthesis you can find the angle
©
berween each detector and the source.
Select datasets to use for your analysis.
Pre-selected detectors are Nals closer than 50
deg to the source, the closest BGO andthe LAT
(if present).
With this application you can download Fermi data for Bata/Bu110731465/911_ospeo_tr_bn110731465_v00.pha’
GRBs and Solar Flares, compute source and B

background spectra for GBM and LAT/LLE data,
perform likelihood analysis and observation simulation
with standard LAT data. done.

gtllebin done!

* vpdating keywords in the headers of the CSPEc file...

& To begin, click on the File menu.
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Clearly a burst!

‘s0® |%| Fermi bursts analysis GUI
File Tasks Tools Update
Trigger name  bn110731465

r
—~\

R.A. (J2000) 280.5 20049 no
Dec. (J2000) -28.5 0+— 1 | 2000
Trigger date (MET) |333803371.953984 7
2500 4 n3 | r 0
0 |
né L/ - 2000
w ni L. 7_ -0 "
i 1000 - I g
3 0 3
] ng L -2000 3
b0 0
2500 ..
0
LAT-LLE L 100
Detectars to display in the LC: 25 LAT 0
v n0 (19 deg) W nl (@4 deg) v n3 (42 dedg) 0
v nB (21 deg) v n7 (47 deg) v nd {48 deg) -1000 750 500 250 0 250 500 750 1000
[w b0 (87 deg) W LAT-LLE (3 deg) v LAT (3 deg) Time since trigger

# €+ Q=B
Loaded datasets: nd.nl n3.n8n7.n9 b0 LAT-LLE,LAT Credits: G.Vianello (giacomov@slac.stanford.edw), N.Omodel (nicola. omodei@gmail. com)

This software embeds:
-gtapps_mp by J. Perkins (http://fermi. gsfc. nasa. gov/ssc/data/analysisaser/)
-&Plpy (http: /faplpy. github. io0/)

|

“You can zoom/pan the light curve using the

e
toolbar at the bottom of the figure, For help on the use )
These packages are property of the respective authors.

of the toolbar, gee - -
y Mak the light L.
http://matplotlib.orefusers/navigation_toolbar html Don;Tg ® iRk twive
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Navigation plots

farmi2an '6\ 140 ' ' ' — éource i llZdegROl'
= g —  Zenith = 100 deg 15 deg ROI
File Tasks Tools Update ‘2’ 120 } =3 10 deg ROI 1
bn110731465 g‘
280.504 100 — — — ol — )
. (J2000) -28.537 S
idger date (MET) |333503371.954 s 80f a i
N |
g 60 1 |
3 \
w 40 ! ! I ! ] n |
—-2000 0 2000 4000 6000 8000 10000 12000 " |
Time since trigger (s) E
S T T T T T T S
] 8
T 80 =
(4] r
_E'n ——————————————— /—\ - - -
© 60 | \ \ -1 |
© \ / |
s 40t ‘ ! -
s /
Jetectors to display in the LC: (] 20} ) 1 / =] 1000
IV LAT (3 deg) g \ | /
(=] SEEA N S
wn AY | | | | !
ead AT —-2000 0 2000 4000 6000 8000 10000 12000 ‘
EoSICAtmactE LR Time since trigger (s)
. You can zoom/pan the light curve using the =
a:lba.r at the bottom of the figure. For help on the us| m gg ﬂi‘ @

fthe toolbar, see Done!

A

|

(=

ittp:/imatplotlib. orgfusers/navigation_toolbar html 7
=~ ——— = T T T == I
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| JON
File Tasks | Tools Update

[%| Fermi bursts analysis GUI

Make likelihood analysis 731465
o source with TS map
nteractively recenter ROI

Make spectra for X5PEC
igger date (MET) [333503371.953984

Detectars to display in the LC:
v n (19 deg) v nd (42 deq) v né (21 ded)
[v b (67 deg) W LAT-LLE (3 deg) W LAT (3 deg)

no
2000 A
U -
n3
l - 2000
-0
20004 g L
3 o
g kO
3 L - 2500
-0
100 4 LAT-LLE
0 B e — Sl *-*-M S|
LAT
- 20
T _-‘-l T — — IL. T T T 0
—-1000 —-750 =500 —-250 0 250 500 750 1000

Time since trigger

A €I+ Q =B

Counts/s

Loaded datasets: nO.n2nd b0 LAT-LLELAT

You can zoom/pan the light curve using the

o
toolbar at the bottom of the figure, For help on the use
of the toolbar, see
http:fmatplotlib.orefusers/navigation toolbar. html

Credits: G.Vianello {giacomov@slac.stanford. edu), N.Omodei (nicola. omodei@gmail. com)

This software embeds:
-gtapps_mp by J. Perkins (http:/ fermi. gsfc. nasa. gov/ssc/data/analysis/users)
-2Plpy (http: faplpy. github. io/)

These packages are property of the respective authors.
Making the light curwve. ..
Done !
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Click here

T

(6] o \ Fermi bursts analysis GUI
} File Tasks Tools Update
Radius of interest] ™4 2 ?
Event class irf pB_transiento20e — | ? :
Limit earth limb| ~ zmax 100 ?
Start time relative to trigger, sttt © ?
Stop time relative to triggerr  tstop 10 ? o 1o
Min energy in MeV/|  emin 100 Z x
Max energy in MeV/|  emax 100000 ? g =%
skybinsize @ 0.2 ? 3 § .
& -30.00° & o
thetamax 180.0 2 >
strategy time — ? S— \;. =l o
.. % oé
1024 % ‘
294.00° 288.00° 282.00° 276.00¢ 270.00° Z'O 4‘0 b‘O t;.? 10'0 lZYU
1/4 Run Next -> Cancel RA (J2000) Time since trigger s

aéé%QEB»

Here you apply cuts on the data. erty

For intervals shorter than 100 s it is usually best

L 4
to use TRANSIENT class, while for longer intervals it
is best to use the cleaner SOURCE class. You can use
the function 'Make navigation plots' in the Tools menu
to decide which Zenith cut it is best to apply.
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— Limit data selection to SED interval
— Relevant event class (Transient20e)

P — — e -
O (©) X\| Fermi bursts analysis GUI
File Tasks Tools Update
rad 12 ?
pB_transient020e e pB_transient010 pB_ultraclean
| ® pB_transient020 pB_source p8_ultracleanveto
irf pa_transiemgzge — ‘7 pB_transient010e e pB_clean pB_transient015s
Zmax 100 ?
tstart 0 ? o
tstop 20 ? 20,002
103 4
emin 100 9
~ -25.00° .
emax 100000 ? S 2
(=] =
~N ,:;
skybinsize 0.2 9 o g
& -30.00° & .
thetamax 180.0 9 o
| a
. .,
strategy time ? | Siggh ® i N ¢
0, *
o ®
102 4 [ -
= T T T T T
| 294.00° 288.00° 282.00° 276.00° 270.00° S 10 15 20 25
1/4 Run Next -> ! Cancel RA ()2000) Time since trigger (s)
-
#€>PQ =
Here you apply cuts on the data. axes property. A removal date has not been set {
get_axes has been deprecated in mpl 1.5, please use the
axes property A removal date has not been set
For intervals shorter than 100 s it is usually best et sy g i gy, emgrooo ol
) operty A removal date has not been set
to use TRANSIENT class, while for longer intervals it been depre i"— 1' oy mpl 1 —r-r please use the
. enova aate as (a]) ee set
is best to use the cleaner SOURCE class. You can use e l‘,ﬁlifm R ',”,,1"1 b r‘?ﬂ:f ibe thn
the function 'Make navigation plots' in the Tools menu A removal date has not been set
to decide which Zenith cut it is best to apply. ;




/0
<o i GBM/LAT GRB Tutorial

Gamma-ray

/ Space Telescope

« (gtburst
— Setting up background models for likelihood
— next-run-next

| Fermi bursts analysis GUI
File Tasks Tools Update

particle model isotr template _4| 7

galactic model template (fixed norm) _nl ?

source_model  powerlawz _.| 7
fgl mode fast _.| 9

<-Prew. |2/ Run ‘ ‘ Cancel ‘

A€+ Q=0

Y ou have to choose which model include in the — |get_axes haf bEEE 'iEPrECitidrirl} npl 1-f5:r pleasi use the
eali ; aXes property. removal date has not heen set.
likelihood gnalyms. See . . get_sxes has been deprecated in mpl 1.5, please use the
http://fermigsfe nasagov/ssc/data/analysis/scitools/so | | |axes property. & removal date has not heen set.
urce_models.html for the list of available spectral get_axes has been deprecated in mpl 1.5, please use the

model for the source model parameter axes property. A removal date has not heen set.
- ' get_axes has been deprecated in mpl 1.5, please use the

axes property. A removal date has not heen set.

Use 'PowerLaw?2' for normal GRB analysis. fe2file -> None =

el
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A GBM/LAT GRB Tutorial
L e
« (gtburst
— XML file, default fits power-law with index=2

e e e e e D e e e e

SenotTrnbinon - than - Bont . amnnh -k 2 s o s

00 (X! Fermi bursts analysis GUI
File Tasks Tools Update

No parameters needed for this command.

Just click Run.
X\ Fermi bursts analysis GUI
- Double click on a parameter to change it.
E Source Name | Name | Vvalue | Enor Min | Max | Scale Free |  Source Type Feature | Feature Type | Featur
4 bn110731465 Integral 0m 1e-06 100000.0 0.001 1 PointSource spectrum PowerLaw?2
| bn110731465 Index -2 -6.0 0.01 1.0 1 PointSource spectrum PowerLaw2
n110731465 LowerLimit 100 200 200000.0 1.0 0 PointSource spectrum PowerLaw?2

hn110731465 UpperLimit 1e+05 200 500000 1.0 0 PointSource spectrum PowerLaw?2

bn110731465 RA 280.5 -360.0 360.0 1.0 0 PointSource spatialModel SkyDirFunction
| bn110731465 DEC -28.5 -90.0 0.0 1.0 0 PointSource spatialModel SkyDirFunction

IsotropicTemplate Normalization 1 0.5 15 1 1 DiffuseSource spectrum FileFunction [-Jiso_P8RZ_TRANSIENTOZ0E_V

IsotropicTemplate Value 1 0.0 10.0 1.0 0 DiffuseSource spatialModel ConstantValue

GalacticTemplate Value 1 07 1.3 1.0 0 DiffuseSource spectrum Constantvalue

GalacticTemplate Normalization 1 0.001 1000.0 1.0 0 DiffuseSource spatialModel MapCubeFunction [-Joll_iem_v06_cut fits

4 J

Done J Save ’

# €3+ Q=B

After clicking 'run’, you can modify the parameters of |~
your likelihood modelby double clicking on the
parameter of interest and setting its new values. When
you are done, click on ‘Save' and then on 'done’.

- Running gteditxmlmodel on dataset LAT with this parameters:

If you have few photons inthe image’ you might | xmlmodel = /home/vagrant/GRBs/GRB110731A/bn110731465_LAT >mlmodel.>ml

want to freeze some parameter otherwise the
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« gtburst
— Optimizing position — runs gtfindsrc after gtlike
— Show model image — makes TS map
— Spectral files — makes XSPEC ready files
— Run -> wait ...

00 X/ Fermi bursts analysis GUI
File Tasks Tools Update

tsmin 20 ?
optimizeposition yes ?

showmodelimage yes - ?
spectralfiles yes ?
liketype unbinned ?

flemin 100 ?
flemax 1000 ?
<-Prev. |4/4 Run Cancel
- 0
A€IPQ=B
Here you will perform a likelihood ana_lysjs onthe - Running gteditxmlmodel on dataset LAT with this parameters ]
data you selected in the first step, using the model you =5, ,,546) - /home /vagrant/GRBs/GRB110731A/bn110731465_LAT smlnodel. xnl

selected in the 2nd step.

The likelihood analysis should take between 5
v 4 rspfile -> /home/vagrant/FermiData/bn110731465/qlg_cspec_n0_bn110731465_v00. rsp2
and 10 minutes to complete. ft2file -> None
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GBM/LAT GRB Tutorial

LAT Likelihood results

Finish

\'
00
File Tasks Tools Um &> +Q =R
tsmin 20 2

optimizeposition yes — | ?
showmodelimage m_~J ?
spectralfiles  yes — | ?
liketype unbinned — ?

flemin 100 2

flemax 1000 2

<-Prev. |4/4 Run Finish! Cancel

Here you will perform a likelihood analysis on the
data you selected in the first step, using the model you
selected in the 2nd step.

@ The likelihood analysis should take between 5
and 10 minutes to complete

ece \ o2

Dec (

#E€EIPQ=

90 % containment radius = 0.265
Distance from initial position = 0.214

NOTE: this new localization VILL NOT be used by default

an the one you started with, update the coordinates yours

l [ ] | Likelihood results
File
| | | | | |
| Source name | Par. Name| Value| Error| Units|
| | | | |
|GalacticTemplate | | | | |
| | Value| 1ln.a. (fixed)| -1
| | Energy flux| 5.19e-08]| 0] ergfom2/s|
| | Photon flux| 0.00011) 0] ph. fem2/s|
|IsotropicTemplate | | | | |
| | HNormalization]| 1.5] 0.173] -
| | Energy flux| 1.67e-07]| 1.93e-08| erg/om/s|
| | Photon flux| 0.00047| L5.42e-05| ph. /cml/s|
|bnl10731465 | | | | |

I| | Inteqral| 0.000495] 6.14e-05| ph. /cmZ/s|
| | Index| -2.43| 0.164| -1
| | LowerLimit| 100 n. a. (fixed)| MeV|
| | UpperLimit| le+05|n. a. {fixed)| Me¥|
| | Energy flux| 1.66e-07] 2.09e-08| erg/cmlss|
| | Photon flux| 0.000476]| 6.04e-05| ph. /cmZ/s|

+++ plus 3 FGL sources with TS<1 (not printed to save space)

Log(likelihood) = 206 751059003
New localization from gtfindsrc:

(R.&., Dec) = (280.344, -23. 664)
68 % contairment radius 0.183
90 % contairment radius

0.265

+++ A1l fluxes and vpper limits have been computed in the 100.0 - 1000.0 energy range.
+++ Upper limits {if any) are computed assuming a photon index of -2.0, with the 95 % c.l.

Results of the last likelihood analysis. Select ‘close’ from the file menu to close this window.
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— Turn off some of the GBM detectors, only need 2 or 3 Nals
(with smallest angle) & 1 BGO

0@ [%| Fermi bursts analysis GUI
File Tasks | Tools Update

Make likelihood analysis 1721465
Find source with TS map - no

Interactively recenter RO 2000 7
Make spectra for X5PEC o
gger date (MET) [333803371.953984 n3
l - 2000
2000 L 0
7 né
7 0 - i
5 b0 =
3 L - 2500 3
Lo
100 A LAT-LLE
0 At vty o — - S o
LAT
Detectars to display in the LC: -2
VN0 (19 deg) [ nl {44 deg) W N3 (42 deg) e P A g
T T T T T T T
N6 (21 deg) [~ n7 {47 deg) [~ nd (48 deg) -1000 -750 -500 -250 0 250 500 750 1000
v b0 (87 deg) W LAT-LLE (3 deg) v LAT (3 deg) Time since trigger
A €2+ Q/=B
Loaded datasets: n0.nl.n3.n6.n7 n9 b0 LAT-LLELAT Sky map : bnllD731465 LAT skymap. fit A
Input XML model : hnl10731465_LAT >mlmodel. zml
Likelihood results (ML) : gll_ftl tr bnll0731465_w00_filt_likeRes.zml
- You can zoom/pan the light curve using the gﬁ;ﬁlg the light curve. ..

©
toolbar at the bottom of the figure. For help onthe use  Meking the light curve. ..

Done !
of the toolbar, see Making the light curve. ..

http:/fmatplotlib.org/users/navigation_toolbar.html Done |
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* interactive or manual interval input

@ [ ] || Fermi bursts analysis GUI
File Tasks Tools Update

intervals

' i
dt None J

==

e hl S d | d nat
ork for me

A€+ Q=0

In this step you have to define the time intervals you = File -5 /home/ & /PerniData bl 10731465 /0l 0 ba110731485 %00, gh &
; ; ; cspecfile - ome fvagrant /FermiData b glg_cspec_n0_hbn _w00. pha
are interested into. IfyOLl want 1o, Jou can rebin the rspfile -» /home/vagrant/FermiData/bnll0731465/glg cspec_nl bnll0731465 w00, rsp2

data by specifying a new bin size dt, and the desired sreintervals -»> /home/vagrant/GRBs/GRE1107318,/bn110731465 nl srcintervals. fits
start and stop time of the rebinned light curve, cspecfile -» /home/vagrant/FermiData/bnll0731465/qlg cspec_n0_bnll0731465 w00, pha
Othervrise, leave dt, tstart and tstop to None' eventfile -> /home/vagrant/FermiData/bnll0731465/glg_tte_n0_bnll0731465 w00 fit

rspfile -» /home/vagrant/FermiData/bnll0731465/glg cspec_n0_bnll0731465 w00, rsp2
ftifile -» None

Insert 'I' or interactive in the form to select srcintervals -» /home/vagrant/GRBs/GRE1107314,/bnl110731465_n0_srcintervals. fits -
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* interactively zoom
e0e

A €

In this step you have to define the time intervals you
are interested into. If vou want to, you can rebin the
data by specifving anew bin size dt, and the desired
start and stop time of the rebinned light curve,
Otherwise, leave dt, tstart and tstop to None',

Insert 'i' or 'inferactive’ in the form to select

= |ft2file

tstart

tstop

dt
srcintervals
cspecfile

+ Get time intervals

Using default event loo

T T T T T T

-10 v] 10 20 30 40
Time since trigger

|%| Fermi bursts analysis GUI
File Tasks Tools Update
intervals |1nteract1ve 7 1165 -
dt None 9
1160 4 N0
tstart -1000 ?
tstop 1000 ? 1155 -
dataset to use n0 — 7 1150 -
" i
£ 1145 4 -
=
i
1140
1135
1130

zoom rect

Hone
shome fvagrant /GREs /GRE1107314,/nl10731465_nl_srcintervals. fits
shome fvagrant /FermiDatabnll10731465 /gl _cspec_nl_bnll0731465_+00. pha

interactively. ..
p until function specific to this GUI is implemented
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* interactively choose source interval

‘ [ NON | [X| Fermi bursts analysis GUI
File Tasks Tools Update

intervals |1nteract1ve P 1165
dt None ?
1160 4 N0
tstart -1000 ?
tstop 1000 ? 1155 A
dataset to use n0 — ? 1150 -
n
w
£ 1145
=
8
1140
1135
1130
Clear
1125 ’( -
' ' ' : E==]
5 5 - -20 -10 0 10 20 30 40
F1 ‘ | Fun ‘ W es ‘ 1 ‘ Time since trigger
# € >4+Q= x=198182  y=1137.05
In this step you have to define the time intervals you |- [ft2file = N;ggn =
are interested into. If you want to, you can rebin the E:Eg;t - 1000
data by specifying anew bin size dt, and the desired dt - None
start and stop time of the rebinned light curve, srcintervals = /home/vagrant/GREs/GRE1107314,/bn110731465_n0_srcintervals. fits
Otherwise, leave dt, tstart and tstop to HMone', cspecfile = /home fvagrant /FermiData/bnll0731465 /gl _cspec_n0_hnll0731465_w00. pha
* Bet time interwvals interactively. ..
Insert 'i' or 'interactive’ in the form to select Using default event loop until function specific to this GUI is implemented -
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 interactively choose background for each detector

@ @ [%| Fermi bursts analysis GUI
File Tasks Tools Update
intervals interactive 7
1600 4
n3
1500 4
1400 4
n
uw
©
3
S 1300
1200 +
1100 4
T T T T T T
—600 —400 —200 v 200 400
’ ‘ ’ ‘ Time since trigger m
--—| Mo
A €3+ Q =R
In this step you wrill produ@e the backgro]_md spectr& - bkgspectra = /home /fvagrant /GREs/GRE1107314,/bnl110731465_n3_bkgspectra. bak |
2 : rspfile = /home fvagrant/FermiData/bnll10731465 /glg_cspec_nd_bnll10731465 +00. rsp2
Ygu have to selgct off-pulse 1nterlvals. The program intervals - intermctive
will then fit a different polynomial for each channel bkgintervals = /home /vagrant /GREs/GRE110731a/bnl10731465 n3_bkgintervals. fits
of the detector, and it wrill interpolaj;e such srcintn_ervals = jhomeivagrant,fGRBs,f‘BRB11073lPxfbnl10731465_n0_3rcintervals. fits
polynomia,ls in the pulse interval(s) to compute the cspecfile = /home fvagrant/FermiData/bnll0731465 /glg cspec_n3_bnll10731465 w00. pha
baCkgro]-md spectrum. * Bet time intervals interactiwvely. ..
Using default event loop until function specific to this GUI is implemented —
Lalact turn timea intertrala nne hafare and nne A
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« resulting fit, retry if it doesn’t look right

[ NON ) |X| Fermi bursts analysis GUI

File Tasks Tools Update
intervals  |interactive ?

3000 A

2500

2000

Counts

1500 4

18 -

7.5 4

5.0 4

2.5

Sigma

0.0 9 JArTaRATRA AT - ik
-2.5 -

T

T T T T
B ‘ N ‘ | B | -400 —200 0 200 400 600 m
- Prens af £ F 10 MNext -> ance]

a € eQ=m |

In this step you will produce the background spectra. | — | /1
ou have to select off-pulse intervals. The program gtllebkg done!

will then fit a different polynomial for each channel qt1lebkqGUI done!

of the detector, and it will interpolate such ) )
polynomials in the pulse interval(s) to compute the Computing residuals...
background spectrum, Dore

Using default event loop until function specific to this GUI is implemented

Calant trirm Hrma intarirale ~na hafrra and fna ¥



s, ML GBM Analysis in Gtburst

« resulting files

[vagrant@host-10-0-2-15 GRB110731A]$ 1s *pha *rsp *bak

bn110731465_b@_bkgspectra.bak bn110731465_n3_weightedrsp.rsp
bn110731465_b@_srcspectra.pha bn110731465_n6_bkgspectra.bak
bn110731465_b0@_weightedrsp.rsp bn110731465_n6_srcspectra.pha

bn110731465_LAT-LLE_bkgspectra.bak bnl110731465_n6_weightedrsp.rsp
bn110731465_LAT-LLE_srcspectra.pha bnl10731465_n7_bkgspectra.bak
bn110731465_LAT-LLE_weightedrsp.rsp bnl10731465_n7_srcspectra.pha

bn110731465_n@_bkgspectra.bak bn110731465_n7_weightedrsp.rsp
bn110731465_n@_srcspectra.pha bn110731465_n9_bkgspectra.bak
bn110731465_n@_weightedrsp.rsp bn110731465_n9_srcspectra.pha
bn110731465_n1_bkgspectra.bak bn110731465_n9_weightedrsp.rsp
bn110731465_n1_srcspectra.pha gll_ftl_tr_bnl10731465_v00_filt_spec_0.000_20.000.bak
bn110731465_n1_weightedrsp.rsp gll_ftl_tr_bnl10731465_v00_filt_spec_0.000_20.000.pha
bn110731465_n3_bkgspectra.bak gll_ftl_tr_bnl10731465_vO0_filt_spec_0.000_20.000.rsp

bn110731465_n3_srcspectra.pha
[vagrant@host-10-0-2-15 GRB110731A7]$% I



s ermi GBM/LAT GRB Tutorial
o S Tacior
- XSPEC

— http://heasarc.nasa.gov/xanadu/xspec/manual/manual.html

— Standard spectral model fitting package, developed in X-ray
community, so a bit X-ray centric (units default in keV)

— Inputs:
« counts/channel spectra
« Background files
 Response files

— Outputs:
* Fit parameters

* Model fit to data in counts space, F,, vF, in energy,
frequency, etc.

« Other spectral fitting packages
— RMFIT
— SHERPA



http://heasarc.nasa.gov/xanadu/xspec/manual/manual.html

A GBM/LAT GRB Tutorial

« Download example prompt.xcm

data 1:1 bn110731465_n3.pha
res 1:1 glg_cspec_n3 _bn110731465_v00.rsp2

data 1:2 bn110731465_n6.pha
res 1:2 glg_cspec_n6_bn110731465_v00.rsp2

data 2:3 bn110731465_b0.pha
res 3 glg_cspec_b0 _bn110731465_vO00.rsp2

data 4:4
gll_ft1_tr bn110731465_v00_filt_spec_0.000_
20.000.pha

Setting up 3 data
groups

 Nal

 BGO

 LAT

This allows us to
do things like free
parameters (e.g.
normalization
constant) in each
group from each
other
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L e

 Let’s set things up

« Let’s plot our data
- plot Idata

cpd /xw
setplot en e
ignore 1:**-8.0
ignore 1:1000.-** )
ignore 3:**-200. .
ignore 3:40e3-** % = I ;
ignore bad L
S
statistic cstat : P ",
statistic pgstat 3 f H
" 10 100 1000 1g;ergy(ke\;)os 106 107 100

jracusin 1-Jun-2017 17:46

cstat = Cash Statistic, pgstat = poison signal with gaussian noise
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« Let’s bin our data (for plotting purposes only)
« setplot rebin <min significance><max # bins><plot group>

data
« setplot rebin 510 1 ey
. setplotrebin5102 ! WM
- setplotrebin5103 st o
- setplotrebin 5204 3 s| T:—k f
 setplotrebin555 g «é T JBF
 plot Idata s L

2 i

feel free to play with these L

numbers to make nicer ST N T A I T

looking plots, it won’t affect 10 00T ey (V) o 10 o

the fitS jracusin 1-Jun-2017 17:41
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) Let,s fit the data to some Model powerlaw<l> Source No.: 1  Active/On

Model Model Component Parameter Unit Value

simple models e
— mode

— [press P
defau i

_ fit100 & oo

Data group: 1

data and felded model

Terrible fit!

0.01
1077

0 L

8 107 gis
* Let’'splot @
E =l

residuals :

- pIOt I( 1570

unts 50 kev™!

rnalized

SELLLEREILL EEL T 1

mts 571 kew ™!

normalized cou

1 " Ll " Lol L Lol L Lol n Ll " Ll " Ll
10 104G 1300 10+ 108 108 107 108
Energy {kev)

[racusin 1

un—2017 17:58

ce
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; Gammamy

/ Space Telescope

* Let’s look at the plot like a SED plotting VF, ¢, unfold the data using the

response functions & model. This makes your spectrum plot model dependent, caution when
interpreting physical models!

plot eeuf res
plot eemo res

Current Theoretical Model
Unfelded Spectrum

T T o T
T T T * / \\\

Wzﬁ ] = ’,“ 100 b ~ g
= 100 —f— ‘ =N 4 .
5 ML e
2 5
T, ’ 2 10
0 L

o
q 10 | 3
E ‘ ! a
G —
2 ‘ % 1
o 1 =Y -,
2 L L " L L . L 3
£ 10 100 1000 10* 10° 108 107 10?
g Energy (kaV)
o 9y
] 01 |44
residuals
.~ 0.01 T
% E; 1 ;
,‘ 1k ‘o
o L]
£ B
2 o ; —
8 =
3
N o=
g ;
§ g
o = A ' L A L 1 ' 1
10 1000 10 10° 10° 107 10 1000 10* 10° 108 107 108
Energy (keV) Energy {(keV)

frocusla 1 —Jun-2017 1800 Jrocusin  1Jun-2017 1218
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Gamma-ray
Space Telescope

« Let’s to a better fit to the data. Try these models
 model grbm
 model grbm+pow
 model grbom+pow+bb

 model const(grbm+pow+bb)
* freeze 1
* untie 19

Unfolded Spectrum Unfolded Spectrum
T r T T T T
\ A
s a7 ““ T
- 100 | =¥ 1 E B = i
% M L Pl 5 CF Tt =+
£ + ' 2 [ = ——— |
2 ; ve—.
: 4 - ” . |
o 10 ¢ 1 ,,,,,, w ‘ E « 10k~ |
§ ™ 5
M M
é 1k } R 8 :
2 2
a g
= L
s 01 F ‘ E £ 0.1
0.01
[ t t t 4 L 0.01
2+
ki 1 k
o |
£ | £ L
2 0 —
ok +
) 3 0
] -1 r
g E
o
4 . " "
10 100 1000 o 10° o® [ o® 10 10 10° o o o
Energy (keV) Energy (kev)

Jrocusla 1 —un-2017 1800 Jrocusin 1 —dun-2017 1810
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* Fit the data
— fit 1000
« May have to do this several times
« Tricks to refine the fit, get out of local minima
— method migrad

* Minuit2 migrad method, useful for getting into the right
ballpark with wider parameter space

— method leven
« Default minimization method, useful for refining fit

— Sometimes useful to go back and forth setting method,
fitting, trying other method

 All these commands are documented here

— http://heasarc.nasa.gov/xanadu/xspec/manual/XScommand
Summary.html



<o i GBM/LAT GRB Tutorial

/ Space Telescope

* You have a fit
— But don’t believe the results just yet ...

Model constant<1>(grbm<2> + powerlaw<3> + bbody<4>) Source No.: 1  Active/On
Model Model Component Parameter Unit Value
par  comp

Data group: 1

1 1 constant factor 6.98173E-02 +/- 5.40843E+04 H
2 2 grbm alpha -2.25451E-03 +/- 0.154769 ever e Ieve t eSe
3 2 grbm beta -1.82868 +/-  3.99082E-02 <«
4 2 grbm tem keV 88.9897 +/- 14.6841
s 2 grbm norm 6.66711E-02 +/- 5.16470E+04 e rro rS eve r'
6 3 powerlaw PhoIndex 5.84980 +/-  2.35146E+06 y .
7 3  powerlaw norm 1.08363 +/-  2.21283E+06
8 4 bbody kT keV 2.83379E-02 +/- -1.00000
9 4 bbody norm 0.102170 +/- -1.00000
Data group: 2
10 1 constant factor 6.98173E-02 = pl
11 2 grbm alpha -2.25451E-03 = p2
12 2 grbm beta -1.82868 = p3
13 2 grbm tem keV 88.9897 = p4
14 2 grbm norm 6.66711E-02 = pS
15 3 powerlaw PhoIndex 5.84980 = p6
16 3 powerlaw norm 1.08363 = p7
17 4 bbody kT keV 2.83379E-02 = p8
18 4 bbody norm 0.102170 = p9
Data group: 3
19 1 constant factor 6.59656E-02 +/- 5.11005E+04
20 2 grbm alpha -2.25451E-03 = p2
21 2 grbm beta -1.82868 = p3
22 2 grbm tem keVv 88.9897 = p4
23 2 grbm norm 6.66711E-02 = p5
24 3 powerlaw PhoIndex 5.84980 = p6
25 3 powerlaw norm 1.08363 =p7
26 4 bbody kT keV 2.83379E-02 = p8
27 4 bbody norm 0.102170 = p9
Fit statistic : C-Statistic 297.43 using 121 bins, spectrum 1, group 1.
Warning: cstat statistic is only valid for Poisson data.
Background file is not Poisson for spectrum 1
C-Statistic 38.18 using 53 bins, spectrum 2, group 1.
Warning: cstat statistic is only valid for Poisson data. .
Background file is not Poisson for spectrum 2 Good neSS Of flt
PG-Statistic 318.19 using 123 bins, spectrum 3, group 1.
C-Statistic 84.40 using 119 bins, spectrum 4, group 2.

Warning: cstat statistic is only valid for Poisson data.
Background file is not Poisson for spectrum 4

C-Statistic 46.81 using 30 bins, spectrum 5, group 3.
Warning: cstat statistic is only valid for Poisson data.
Source file is not Poisson for spectrum 5

Background file is not Poisson for spectrum 5

Total fit statistic 785.02 with 436 d.o.f.
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« Errors on parameters and local minima
— Sometime will find new better fit, and you can start over
— Confidence interval default = 90%, can change

XSPEC12>error 1-6
Confidence Range (2.706)

Parameter
Number of trials exceeded:
Number of trials exceeded:
Number of trials exceeded:

1

Apparent non-monotonicity
Current bracket values -2

-0.744889

-0.193892

and delta stat 2.69048, 3.31576

but latest trial -2.25736

continue fitting?
continue fitting?
continue fitting?

(-0.260579,0.290418)

in statistic space detected.
.25746, -2.25356

gives 2.685

Suggest that you check this result using the steppar command.

2

3
4
5
6

-2.40369
127.898
0.0214608
1.93526
7.96772

-2.25551
232.325
0.0303339
2.45999
39.5745

(-0.0739512,0.0742339)
(-41.8045,62.6225)
(-0.00350109,0.00537204)
(-0.0674719,0.457264)
(-8.86897,22.7378)
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 XSPEC can do lots of other useful things
— Many spectral models

* http://heasarc.nasa.gov/xanadu/xspec/manual/Models.ht
ml

— Calculate fluxes over energy range

 If you want de-absorbed X-ray fluxes (true emitted flux),
you can set the nH=0 after fitting

— Can even simulate data using fakeit command

— Can fit offsets for different datasets if cross-calibration is
uncertain

« different fit parameters (e.g. normalizations) for different
instruments

— Plot data in counts, F,, vF,



http://heasarc.nasa.gov/xanadu/xspec/manual/Models.html
http://heasarc.nasa.gov/xanadu/xspec/manual/Models.html

s, L What else?

* Do this in time-resolved analysis
 measure evolution of parameters
« are all components seen in every interval
* ftest for nested models

 more sophisticated simulations
potentially required

 Rmfit can also do these joint fits



